
 

GUÍA DE SERVICIOS POR INTERNET PARA EMPRESAS (BSO, 
SUS SIGLAS EN INGLÉS) PARA EL AÑO TRIBUTABLE 2008 

(TY08, SUS SIGLAS EN INGLÉS) 

 
SERVICIO W-2C ONLINE 

 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
Contiene las siguientes lecciones:  
 

• Cómo crear un formulario W-2c Online 
 

• Cómo descargar los formularios W-2c ya presentados 

• Cómo reanudar los formularios W-2c que aún no ha presentado 
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LECCIÓN 1: CÓMO CREAR UN FORMULARIO W-2C ONLINE 
 
Siga las siguientes instrucciones para crear hasta cinco formularios W-2c Online. 
 
PASO 1 Dirija su navegador a la página titulada, «Business Services Online Welcome» 

(Bienvenido a los Servicios por Internet para Empresas): 
: 

www.segurosocial.gov/bso/bsowelcome.htm (sólo disponible en inglés). 
 

 
 
PASO 2: Pulse en el botón que lee, «Login» (Ingrese) en la página titulada, «Business Services 

Online Welcome». El sistema mostrará en pantalla la página titulada, «Log In to BSO»  
(Ingrese al BSO). 
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PASO 3 Ingrese su «User ID» (Identificación de Usuario) y contraseña.  

 
: 

: PASO 4 Pulse el encasillado que lee, «I Accept» (Acepto) después de leer las condiciones 
definidas en la página titulada, «Log In to BSO». Pulse en el botón que lee, «Login» 
(Ingrese). El sistema mostrará la página titulada, «BSO Main Menu » (página principal 
del BSO). (Para regresar a la página inicial del BSO [que lee, «Business Services Online 
Welcome], pulse en el botón que lee, «Cancel» [Cancelar].) 
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PASO 5 Pulse en el enlace que lee, «Report Wages to Social Security» (Informe los salarios al 

Seguro Social). 
: 

 

 
 
El sistema mostrará la página de opciones de tareas titulada, «Report Wages to Social Security». 
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PASO 6: Pulse en el enlace que lee, «Submit or Resubmit Wage File, W-2 Online, and W-2c 

Online and View Submission Status» (Presentar por primera vez u otra vez un archivo de 
salario, W-2 por Internet, W-2c por Internet y ver el estado de los datos presentados).  

 

 
El sistema mostrará en pantalla la página de opciones de tareas titulada, «Submit or Resubmit Wage 
File, W-2 Online, and W-2c Online and View Submission Status». 
 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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PASO 7 Seleccione en el enlace que lee, «Enter Forms W-2c» (Ingrese los formularios W-2c). 

 
: 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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 El sistema mostrará en pantalla la página titulada, «Wage Reporting Attestation» 

(Confirmación de los informes de salarios). 
 

 
 
 
PASO 8 Pulse en el botón que lee, «I Accept» (Acepto) después de leer las condiciones definidas 

en la página titulada, «Wage Reporting Attestation». Si tiene algún registro que todavía 
no ha presentado, el sistema mostrará en pantalla la página titulada, «W-2 Online 
Information the Tax Year 2008 (TY08) (Información sobre el formulario W-2 por 
Internet para el año tributable 2008 [TY08]).  
 

: 

 

EA 

Si tiene algún informe que todavía no ha presentado, el sistema mostrará en pantalla 
la página titulada, «W-2c Online Unsubmitted Reports for the TY08» (Informe de 
salarios del formulario W-2c por Internet que todavía no se han presentado). Para el 
TY08, puede tener hasta un máximo de 50 informes de salarios que no haya 
NOTNOT
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presentado. Cuando haya alcanzado el límite de 50 informes que ha «guardado», se le 
requerirá que presente uno de los informes guardados antes de que se le permita 
comenzar un registro nuevo.  Si tiene 49 puede continuar sin que se le requiera 
presentar los informes que ya existen pulsando en el botón que lee, «Start a New 
Report» (Comenzar un registro nuevo). Infórmese mejor, leyendo la LECCIÓN  3: 
Cómo reanudar los formularios W-2c que todavía  no ha presentados. 
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PASO 9 Pulse en la respuesta apropiada en la sección que lee, «FOR WHOM ARE YOU 

FILING?» (¿PARA QUIÉN ESTÁ PRESENTANDO EL INFORME?) después de 
revisar la información de inscripción. 

: 

: 

  

Los botones a la pregunta «FOR WHOM ARE YOU FILING?» no están a las 
disposición de las personas que trabajan por cuenta propia. 

 NOTENOTA 
 

 
PASO 10 Pulse en el botón que lee, «Continue» (Continuar) después de leer el aviso de la Ley de 

Confidencialidad y la Ley de Reducción de Trámites. El sistema mostrará en pantalla la 
página titulada, «W-2c Online Employer Data for the TY08 (Información Empresarial 
para el año tributable 2008 (TY08), del servicio W-2c Online). (De lo contrario, 
seleccione el botón de Cancel para terminar la sesión y regresar a la página, BSO Main 
Menu.) 
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PASO 11 Ingrese su información de empleador. Si usted está presentando el informe para su propia 

empresa, el sistema automáticamente propagará la información. 
: 

: 

 
 

NOTENOTA 

Todos los encasillados marcados con un asterisco (*) tienen que ser completados. 
 
 
 
 

PASO 12 Pulse en el botón que lee, «Continue» (Continuar).  El sistema mostrará en pantalla la 
página titulada, «W-2c Online Form W-2c for the TY08». (De lo contrario, pulse en el 
botón que lee, «Cancel» [Cancelar] para regresar a la página principal del BSO titulada, 
«BSO Main Menu».) 

 
 
 

NOTENOTA 

Si hay uno o más formularios W-2c guardados, el sistema mostrará en pantalla la 
página titulada, «W-2c Online Data Review» (Revisión de la información, del 
formulario electrónico «W-2c Online»). Continúe al PASO 16. 
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PASO 13 Ingrese las correcciones de la información del formulario W-2 en los encasillados  

correspondientes. No llene los encasillados que fueron informados correctamente la 
primera vez que presentó el formulario W-2. 
 

: 

: 

: 

PASO 14 Pulse en el botón que lee, «New W-2c» (W-2c nuevo) para guardar esta información y  
crear otro formulario W-2c. De lo contrario, pulse en el botón que lee, «Done» 
(Terminado) para guardar la información del W-2c que acaba de terminar y proceder a la 
página titulada, «W-2c Online Data Review for the TY08». También puede pulsar en el 
botón que lee, «Cancel» para borrar los datos ingresados a este formulario W-2c. 

 
 
 
Usted puede ingresar  un máximo de cinco (5) formularios W-2c por sesión. Una vez 
ingrese el quinto formulario, el sistema ya no mostrará el botón que lee, « New W-2c.  
Si desea ingresar más formularios W-2c, será necesario que salga del sistema e 
ingrese otra vez. No hay límite en la cantidad de sesiones.   NOTENOTA 
 

 
 
PASO 15 Después que pulse en el botón que lee, «New W-2c» o el que lee, «Done», posiblemente 

reciba un aviso en pantalla. Si es así, debe revisar su información y hacer cualquier 
corrección o pulsar en la respuesta que lee, «Override» (Ignorar) para cada aviso. Luego, 
pulse en el botón que lee, «New W-2c» para crear un nuevo registro de W-2c o pulse en 
el botón que lee, «Done» para proceder a la página titulada, «W-2c Online Data Review 
for the TY08». 
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PASO 16 Pulse en el botón que se encuentra al lado del informe correspondiente lee, «View/Edit» 
(Ver/Editar) para ver o editar la información del formulario W-2c. Si quiere borrar la 
información que ingresó en el formulario W-2c, pulse en el botón que lee, «Delete» 
(Borrar) al lado del informe correspondiente. 
 

: 
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PASO 17 Pulse una de las siguientes tareas: «New W-2c» (W-2c nuevo), «Edit Employer Info» 

(Editar la información patronal), «Go to W-3c» (Ingrese al formulario W-3c), «Save & 
Quit» (Guardar la información y Salir), o «Quit and Delete» (Terminar y Borrar). 

: 

: 

 
 

NOTENOTA 

 La opción «New W-2c» no estará disponible si ya ha guardado cinco formularios  
W-2c en el informe actual o si se ha alcanzado el límite de 50 W-2c guardados pero 
no presentados. La opción «Go to W-3c» no estará disponible si no existen 
formularios W-2c guardados para la empresa. 
 
 

PASO 18 Pulse en el botón que lee, «Go to W-3c» para presentar la información de salarios. El 
sistema mostrará en pantalla la información en formato electrónico de los formularios  
W-2c Online y W-3c correspondientes al TY08 para su revisión. 
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PASO 19 Seleccione una de las siguientes opciones: 

 
Pulse en el botón que lee, «Submit Corrected Wage Report» (Presente registros de 
salario corregidos) para presentar información de salarios. Continúe al 

: 

PASO 21 para 
informarse mejor. 
 
Pulse en el botón que lee, «Print Corrected Wage Report» (Imprima los registros de 
salario corregidos) para echarle una vista preliminar a los informes de salarios antes de 
presentarlos al Seguro Social. Continúe al PASO 25 para informarse mejor. 
 
Pulse en el botón que lee, «Return to W-2c Online Data Review page» (Regrese a la 
página de revisión de información del formulario W-2c Online). 
 

PASO 20: Pulse en el botón que lee, «Submit Corrected Wage Report» en la página titulada,  
«W-2c Online Form W-3c for the TY08».  

 

 
 
PASO 21: Si hay múltiples Números de Identificación de empleador (EIN, sus siglas en inglés) 

asociados con el presentador, entonces aparecerá en pantalla un encasillado de lista 
de EIN’s. Debe seleccionar un EIN de la lista; de lo contrario, proceda al PASO 23. 
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Se le recomienda que pulse en la palabra «OK», para imprimir ahora, en la 
ventanilla desplegable que aparece al llegar a la página titulada,«W-2c Online 
Receipt Acknowledgement». NOTENOTA 

 
 
 
PASO 22 Pulse en el botón derecho de su ratón para guardar el archivo de salarios. 

 
: 

: PASO 23 Pulse en la opción que lee, «Save Target As» del menú de su navegador para guardar el 
expediente. (De lo contrario, pulse en el botón que lee, «Continue» [Continuar].) 

 
 
 
 

NOTENOTA 

Puede descargar el informe de salarios corregido que haya  presentado hasta 30 días 
después de la fecha en que lo presentó usando la función que se encuentra en  
LECCIÓN  2: Cómo descargar los formularios W-2c ya presentados. 
 

 
PASO 24 Pulse en el botón que lee, «Continue» (Continuar). El sistema mostrará en pantalla la 

página titulada, «W-2c Online Thank You» (Gracias por usar el servicio W-2c Online). 
 

: 
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PASO 25 Pulse en el botón que lee, «Print Corrected Wage Report» en la página titulada, «W-2c 

Online Form W-3c» para imprimir el informe de salarios corregido. El sistema mostrará 
en pantalla la página titulada, «W-2c Online Report Print» (Imprima un informe del 
servicio W-2c Online). 

: 

 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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NOTENOTA 

 
Si su computadora no tiene una copia del programa «Adobe Acrobat Reader», puede 
descargarlo pulsando en el enlace que lee, «follow this link» (siga este enlace) que se 
encuentra en el medio de la página. 
 
 

 
PASO 26 Pulse en el enlace que lee, «Print Preview». El sistema mostrará en pantalla los 

formularios W-2c en formato electrónico. 
 

: 

: 

: 

: 

: 

PASO 27 Pulse en la palabra que lee, «File» (Expediente) en la parte superior de su navegador a la 
izquierda, luego busque la palabra «Print» (Imprimir) o pulse en el icono de la impresora 
que aparece en la segunda línea de su navegador. 
 

PASO 28 Para cerrar la ventana después de imprimir, pulse en la palabra que lee, «File» en su 
navegador, luego en la palabra que lee, «Close». El sistema lo regresará a la página 
titulada, «Print Preview». 
 

PASO 29 Las opciones que aparecen en la página titulada, «W-2c Online Report Print» le 
permitirán presentar el informe de salarios corregido al Seguro Social,  regresar a la 
página titulada, «W-c Online Form W-3c», regresar a la página titulada, «W-2c Online 
Data Review», guardar su información, o salir sin guardar su información. 
 

PASO 30 Pulse en el botón que lee, «Return to W-2c Data Review Page» en la página titulada,  
«W-2c Online Form W-3c» para editar la información del formulario W-2c. El sistema lo 
regresará a la página titulada, «W-2c Online Data Review». 
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LECCIÓN 2: CÓMO DESCARGAR LOS FORMULARIOS 
W-2C QUE YA HA PRESENTADO 

 

Siga las siguientes instrucciones para descargar los registros en formato de «Adobe» los cuales  
contienen los formularios W-2c y W-3c de un informe presentado a través del servicio de «W-2c 
Online» que haya presentado durante los últimos 30 días. 
 

 

Los registros en formato de «Adobe» están disponibles por 30 días o hasta el 11 de 
diciembre del 2008. 

NOTENOTA  
 

 
Paso 1: Dirija su navegador a la página titulada, Business Services Online Welcome (Bienvenido 

a los Servicios por Internet para Empresas): www.segurosocial.gov/bso/bsowelcome.htm 
(sólo disponible en inglés). 
 

Paso 2: Pulse en el enlace de que lee, «Login» (Ingrese) en la página titulada, «Business Services 
Online Welcome». El sistema mostrará en pantalla la página titulada, «Log In to BSO» 
(Ingrese al BSO). 
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Paso 3: Ingrese su «User ID» (Identificación de Usuario) y contraseña. 

 
Paso 4: Pulse en el encasillado que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, «Log In to BSO». Pulse en el botón que lee, «Login». El 
sistema mostrará la página titulada, «BSO Main Menu » (página principal del BSO). (Para 
regresar a la página inicial del BSO [que lee, «Business Services Online Welcome], pulse 
en el botón que lee, «Cancel» [Cancelar].) 
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Paso 5: Pulse en el enlace que lee, «Report Wages to Social Security» (Informe los salarios al 

Seguro Social). 
 

 
 
El sistema mostrará la página de opciones de tareas titulada, «Report Wages to Social Security». 
 

 
 
Paso 6: Pulse en el botón que lee, «Submit or Resubmit Wage File, W-2 Online, and W-2c 

Online and View Submission Status» (Presente por primera vez u otra vez los informes 
de salario, W-2 y W-2c en formato electrónico y ver el estado de los datos presentados). 
 
El sistema mostrará la pagina de opciones de tareas titulada, «Submit or Resubmit 
Wage File, W-2 Online, and W-2c Online and View Submission Status». 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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Paso 7: Pulse en el enlace que lee, «Dowload Submitted W-2cs» (Descargar formularios W-2c 

ya presentados).   
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
 

 
 
 
 El sistema mostrará en pantalla la página titulada, «Wage Reporting Attestation» 

(Confirmación de los informes de salarios).  

2827.4561.BSO.1.0                                                                                                                                                            29 de agosto del 2008 



GUÍA DE SERVICIOS POR INTERNET PARA EMPRESAS (BSO) PARA EL AÑO TRIBUTABLE  2008 (TY08) 
SERVICIO W-2C ONLINE  

  

   
Administración del Seguro Social                                 28           
 

 
 
Paso 8: Pulse en el botón que lee, «I Accept» (Acepto) después de leer las condiciones definidas 

en la página titulada, «Wage Reporting Attestation». El sistema mostrará en pantalla la 
página titulada, «W-2c Online Download for the TY08» (Descargo para el TY08, del 
servicio de W-2c en formato electrónico). 

 
(Para regresar a la página principal del BSO [titulada, «BSO Main Menu»], pulse en el botón que lee, 
«I DO NOT Accept» [No Acepto].) 
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Paso 9: Posicione el indicador de su ratón sobre el enlace de WFID que desea descargar y oprima 

el botón derecho de su ratón. 
 

Paso 10: Pulse en la opción que lee, «Save Target As» (Guardar el objetivo como) del menú del 
navegador para descargar el archivo a su computadora. 

 
Paso 11: Pulse en el enlace que lee, «BSO Main Menu» (Página principal de opciones de tareas 

del BSO) para regresar a la página principal del BSO. 
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LECCIÓN 3: CÓMO REANUDAR LOS FORMULARIOS W-2C QUE  
AÚN NO HA PRESENTADO 

 
Siga las siguientes instrucciones para continuar trabajando con los informes del servicio «W-2c 
Online» que ha guardado pero aún no ha presentado.  El Seguro Social borrará cualquier informe 
guardado que usted no presente o actualice dentro de 90 días.  Todos los formularios W-2c que no son 
presentados serán borrados el 31 de diciembre del 2008. 
 

Puede tener hasta 50 informes guardados con cinco formularios W-2c en cada 
informe. 

NOTENOTA 
 
 
 
 

PASO 1: Dirija su navegador a la página titulada, «BSO Welcome» (Bienvenido a los Servicios 
por Internet para Empresas): www.segurosocial.gov/bso/bsowelcome.htm (sólo 
disponible en inglés). 
 

PASO 2: Pulse en el botón que lee, «Login» (Ingrese) en la página titulada, «BSO Welcome». El 
sistema mostrará en pantalla la página titulada, «Log In to BSO» (Ingrese al BSO). 
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PASO 3: Ingrese su «User ID» (Identificación de Usuario) y contraseña. 
 
PASO 4: Pulse en el encasillado que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, «Log In to BSO». Pulse en el botón que lee, «Login» 
(Ingrese) para ver la página principal de opciones del BSO titulada, «BSO Main Menu». 
(Para regresar a la página inicial del BSO [que lee, «Business Services Online Welcome], 
pulse en el botón que lee, «Cancel» [Cancelar].) 

 
PASO 5: Seleccione el enlace que lee, «Report Wages to Social Security» (Informe los salarios al 

Seguro Social). 
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El sistema mostrará la página de opciones de tareas titulada «Report Wages to Social Security». 
 

 
 
PASO 6: Pulse en el botón que lee, «Submit or Resubmit Wage File, W-2 Online, and W-2c 

Online and View Submission Status» (Presente por primera vez u otra vez los datos de 
salario, W-2 y W-2c en formato electrónico y ver el estado de los datos presentados). 
 
El sistema mostrará en pantalla la pagina de opciones de tareas titulada, «Submit or 
Resubmit Wage File, W-2 Online, and W-2c Online and View Submission Status». 

 
(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el 
botón que lee, «BSO Main Menu».) 
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PASO 7: Pulse en el enlace que lee, «Resume Unsubmitted W-2cs» (Reanudar los formularios 

W-2c que todavía no ha presentado). 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el 
botón que lee, «BSO Main Menu».) 

 
 

 
 

El sistema mostrará en pantalla la página titulada, «Wage Reporting Attestation» 
(Confirmación de los informes de salarios). 
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PASO 8: Pulse en el botón que lee, «I Accept» (Acepto) después de leer las condiciones en la 

página titulada, «Wage Reporting Attestation». El sistema mostrará en pantalla la página 
titulada, «W-2c Online Unsubmitted Reports for the TY08 (Formularios de formato 
electrónico W-2c que todavía no ha presentado para el TY08). 

 

 
 

PASO 9: Pulse en el botón que lee, «View/Edit» (Ver y Editar) para el informe específico que 
desea ver o modificar. El sistema mostrará en pantalla la página titulada, «W-2c Online 
Data Review for the TY08» (Revisión de información para el TY08, del servicio W-2c 
Online). (Para borrar el informe, pulse en el botón que lee, «Delete» [Borrar] para el 
informe específico.) 
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NOTENOTA 

 
El botón que lee, «New W-2c» (W-2c nuevo) no aparecerá en pantalla si tiene la 
cantidad máxima de formularios W-2c que aún no ha presentado (cinco) por informe. 
El botón que lee, «Go to W-3c» (Vaya al W-3c) no aparecerá en pantalla si no existe 
ningún formulario W-2c que no se haya presentado todavía. 
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PASO 10: Pulse en el botón que lee, «Go to W-3c» (Vaya al W-3c). El sistema mostrará en 
pantalla su formulario W-3c. Pulse en las opciones apropiadas que se encuentran en esta página para 
presentar su informe de salarios, imprimir su informe de salarios, o regresar a los formularios W-2c 
que todavía no haya 
presentado
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